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LUNDS TEKNISKA HOGSKOLA

Lunds universitet

Introduction to the
lab environment

Purpose

The purpose of this laboratory exercise is to give an introduction to the lab
environment that will be used throughout the labs in the Computer Organization
course EITEF70. One should get the knowledge on how to use the Xilinx SDK tool
to setup, debug and run application projects. Furthermore, one should get the
knowledge on how to write a simple application program in the high level
programming language C, understand the different data types and how data is stored
1n memory.

The Lab Environment

Throughout the labs of this course we shall use the Xilinx SDK tool to create
different applications that will be executed on a specific hardware platform that is
implemented on an FPGA board. The application projects are to be written in the
high level programming language C. The applications are to be executed on a
hardware platform specifically tailored for the needs of this course. The hardware
platform is based on a 32-bit RISC (Reduced Instruction Set Computer) processor,
MicroBlaze. The MicroBlaze processor is a soft microprocessor core designed by
Xilinx. The MicroBlaze core can be used to design hardware that can be
implemented on a Xilinx FPGA (Field Programmable Gate Array) board. An FPGA
is an integrated circuit that contains an array of programmable logic blocks. By
programming the FPGA one can implement different hardware designs that are
specified using a hardware description language (HDL). In these labs, we shall use
the Nexys 4 FPGA board. Apart from the FPGA, this board contains a number of
ports and peripherals allowing it to host designs ranging from introductory
combinational circuits to powerful processors. Throughout the labs, we shall use
primarily the following peripherals available on the Nexys 4 board: the 16 switches,
the 16 LEDs, the eight seven-segment displays and the five pushbuttons. The Nexys
4 board, along with the peripherals discussed earlier, is illustrated in Figure 1.
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Figure 1. Nexys 4 board
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The Hardware Platform

The hardware platform is based on a MicroBlaze microprocessor. The processor is
connected to a number of I/O devices and a memory. The following 1/O devices
are available:

SWITCHES, a configurable 1/O device interfacing the 16 switches
available on the Nexys 4 board

LEDS, a configurable 1/O device interfacing the 16 LEDs available on
the Nexys 4 board

7SEGMENT DISPLAYS, an output device interfacing the 8 seven-
segment displays available on the Nexys 4 board

PUSH BUTTONS, a configurable 1/O device interfacing the five
pushbuttons available on the Nexys 4board

TIMERT, a configurable timer/counter device that can generate
interrupts

TIMER2, a configurable timer/counter device that can generate
interrupts

INTERRUPT CONTROLLER, used for combining multiple

interrupts that come from various devices, namely, the timers.

The memory stores the program that is to be executed by the MicroBlaze
microprocessor. Furthermore, all necessary data is stored in the memory. A block
representation of the hardware platform is given in Figure 2.

The MicroBlaze microprocessor operates at 100MHZ frequency.
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MicroBlaze
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DATA BUS

CONTROLBUS

7SEGMENT PUSH INTERRUPT
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Figure 2. The hardware platform
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The Xilinx SDK

This part guides you through the process of setting up a new project using the Xilinx
SDK tool. It includes the different steps, namely, setting up the workspace, creating
a new project, setting up the target hardware platform, writing the first application,
programming the FPGA and running/debugging the application.

Setting up the workspace for Xilinx SDK

In the file explorer, create a folder with the name “EITF70” (or choose a different
name that does not contain any other characters except for digits and letters) in the
following location “C:\Users\wser_name\”, whete wuser_name is your login ID. All
projects that will be created during the labs of this course will be stored in this
folder, and it is referred to as a workspace. When you open Xilinx SDK, the
tollowing window pops up:

SDK

Software Development Kit

£l Workspace Launche

Select a workspace

Xilinx SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: v Browse...

[ Use this as the default and do not ask again

Figure 3. Setting up the workspace

Click the “Browse” button, and locate the folder that you have just created, or just
type in “C:\Users\user_name\folder”, whete user_name is your login 1D and folder is the
name of the folder that you have created. Next, click the “OK” button.
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Note that the workspace is located on the local drive “C:\” and hence, it only exists
on the particular machine on which you are working. To enable portability, once you
are done with a lab session, copy the workspace to your network drive “H:\”. Next
time you log in to a different machine, copy the workspace from your network drive
“H:\” to “C:\Users\user_name\” to resume the work from the last lab session.

Creating a new project

To create a new project, from the File menu, select new application project, as
illustrated in Figure 4.

.
ER c/c++ - Xilinx SDK o | B e
Edit Source Refactor Navigate Search Project XilinxTools Run Window Help

New Alt+Shift+N » | & Application Project v B v Q- Q™ v &l v > |
Open File... EA  SPM Project Quick Access l B % C/C++
Close Ctrl+W B | Board Support Package = 8 ||gEou. B|@Ma.| = 8
Close All CtrteShiftsw |1 Project-
Save Chl:S &9 Source Folder An outline is not available.
- R (Y Folder
Save As.. N )
Save All Ctrl+Shiftvs | L& SourceFile
REven h| Header File
¥ File from Template
Move... & Class
Rename... F2 R
Refresh g5 | O Other... Ctrl+N
Convert Line Delimiters To >
Print... Ctrl+P l
Switch Workspace »
Restart
g2y Import...
sy Export..
Properties Alt+Enter
Exit |
4 Target Connections 22 | & = 8 ||[ pro.. 2| ¥ Tasks| & Con...| = Pro... | @ Ter.. | = O SDK Log &2 B =08
-4 Local [default] || 17:37:20 INFO  : Launching XSDB server: xsdb.bat
(= Auto Discovered 0 items
Description : Resource
< i ) < m »

Figure 4. Creating a new project

The applications that will be created throughout the labs will be written in C
language. All applications should be executed on a hardware platform that has been
specifically designed for the purpose of this course. The hardware platform is based
on a MicroBlaze processor, an intellectual property (IP) softcore provided by Xilinx.
Observe that when you start using the Xilinx SDK tool, there is a set of predefined
hardware platforms that you can choose from. However, the hardware platform that
you need to use is not available in this list. Therefore, you first need to add the new
hardware platform.
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Setting up the target hardware platform

To add the new hardware platform, download the hardware specification that is
available on the course web-page (“MicroBlazeHWPlatform.hdf”) and save it in
“C:\Users\user_name\”, whete wuser_name is your login ID. Note that this file must
have the extension “.hdf”’. Next, in the Target Hardware section, click the “New”
button as illustrated in Figure 5.

~
@ New Project uﬂléj

Application Project P
Project name must be specified i /

Project name:

[¥] Use default location

EITO70 Browse...
default
Target Hardware
Hardware Platform: [ZC702_hw_pIatform(pre-defined) v I New
Processor: [ ps7_cortexad_0 v
Target Software
Language: @ C ()C++
OS Platform: standalone v

Board Support Package: @ Create New

Use existing

5\
'\?) < Back Next > Finish

Figure 5. Adding a new hardware platform

By following these steps, you are creating a new hardware project. Name this project
as “MicroBlazePlatform”. For the hardware specification, click the “Browse” button
and locate the hardware specification file that you downloaded from the course web-
page. This is illustrated in Figure 6.
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-
N New Hardware Project” y o o (e

New Hardware Project -
. (= |
Create a new Hardware Project. =
[R—
Project name: MicroBlazePlatform
Use default location
EITO70\MicroBlazePlatform Browse...

default

Target Hardware Specification

Provide the path to the hardware specification file exported from Vivado.
This file usually resides in SDK/SDK_Export/hw folder relative to the Vivado project location.
The specification file and associated bitstream content will be copied into the workspace.

system_0_wrapper.hdf

™\

@) [ Finish ] [ Cancel

Figure 6. Creating a new hardware project

By completing these steps, you have successfully created a new application project
that runs on the hardware platform designed for the purposes of this course.

By using the same workspace, next time when you create a project, the target
hardware platform will be available in the drop-down list, and thus, it is sufficient to
do this step only once. However, the labs are organized such that you only need one
project that you will use in the remaining laboratory exercises.

To be able to write an application in your application project you need to add a
source file where you write the code. To add a source file to the project, in the
Project Explorer, select the “stc” folder of the project to which you want to add the
source file, click the right mouse button, and select new source file. These steps are
illustrated in Figure 7. For future reference, name this file as “main.c”. This file will
contain the main program that will be executed when you run the project.
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[0 C/C++ - Lab1_bsp/sy:
File Edit Source R

Novigate Search Project XiinkTools Run Window Help
ThEREED NG v E v H ORI E B S

(&5 Project Explorer 03 = O |[Gg systemhdf |3 systemumss 23

2g|Y ~
- Labl_bsp Board S rt Pack:
4 S Labl P oS An outline is not available.

&) Includes

X7 Modify this BSP's Settings | [Re-qenerate BSP Sources
0 Labl§  New »[F9 Project..

& Microl
1 Microl Golnto File

Open in New Window File from Template g target
> | Copy ot | O Folder icroBlazePlatform)system.hf
(=5 CtlsV | @ Class
X Delete Delete | [ Hea
Source + & Sou
Move. &
Reneme... R
&
22 Import =
| v [3 | Other... CtrlsN
£) Refresh 5 pmm—

BR=-0o

&8 Target Col
4 Local |
& Auof

Restore from Local History... ° Resource

18:07:08 INFO  : Project "MicroBlazePlatform’ crl
% Run C/Ce+ Code Analysis 7 |

Properties AltsEnter

& /Labl/src

Figure 7. Adding a new source file

The first C program

In the recently created source file, i.e. “main.c”, type the following code:

char b;
int main(){
b=9;
while (1==1){
if (b<10){
b--;
}

Analyze the code.
* What does the code do?

* Whatis the expected value of the variable “b”’?

Running/debugging the program

Before you can run/debug the program, two steps need to be performed. First, you
need to program the FPGA of the Nexys 4 board according to the provided
hardware specification. To do so, click the “Program FPGA” & button. Obsetve
that this process is only done as long as the FPGA has not been programmed
before. Once the FPGA is programmed, i.e. the hardware platform is implemented
on the FPGA, the same hardware platform will be available until the board is
disconnected from the computer. Initially, the FPGA board is not programmed.
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Once the FPGA is programmed, the second step is to build the project. This step is

responsible to convert the source files into executable files that later can be executed

by the MicroBlaze processor. To build the project, click the “Build All” ¢ button.
Make sure that all the changes in the source file are saved, before you build the
project. To save the changes in a source file, click the “Save All” ‘@ button. By
default, whenever you save the changes in the source files, a build is performed.

Now, you are ready to run/debug the program. To run/debug the program, in the
Project Explorer, select the project application that you want to run, click the right
mouse button and select “Debug As”—>”4 Launch on Hardware (GDB)”. These
steps are illustrated Figure 8 (Note: The option GDB was numbered as 1 in an
older version of the tool, however in the latest version GDB is numbered as 4).

r Y
d - - Xili =NACAl X
Hf c/C++ - Labl/sre/Lablc Xilinx SDK b oh
File Edit Source Refactor Navigate Search Project XilinxTools Run Window Help
9 - EEXST T 11 1o g erd-GfHfo-a-® -
.= 4 New » Quick Access [ & | ([ cc+
S Go Into =
{5 Project E! | system.mss [€ Labl.c 52 = 8| Eou. B|@Ma. = O
Open in New Window - =| laz V] \S o % v
4 |5 Labl| = Copy ChItE ® b:char
B g ;
% B Paste Ctrl+V n: 29 jun 2015 @ main():int
B I r: eit-dni
&0 ¥ Delete Delete
PR Source »
{ Move...
i Rename... F2
E =1){
s Labl pxg Import... <10){
d} Micr| 4 Export.. =2
Build Project
Clean Project
Refresh F5
Close Project I

Close Unrelated Projects

Build Configurations »
Make Targets »
Index »

Show in Remote Systems view
< n »

Profiling Tools »
4 Target C{ Convert To... ks| B Con.. E Pro.. | @Ter.. | = O SDK Log 3 = B
4 loca Profile As » || 18:0
& Auta Debug As » | £ 1 Launch on Hardware (GDB)
Run As > ?EF 2 Launch on Hardware (System Debugger)
Team » | [€] 3Local C/C++ Application
Compare With > é 4 Remote ARM Linux Application
Restore from Local History... A 5 Start Performance Analysis ,‘

Wl Change Referenced BSP Debug Configurations...

&5 Labl

F == 4

Figure 8. Running/Debugging the application

To run/debug the program you can also use the shortcut button B , where from
the drop-down list you select “Debug As=>4 Launch on Hardware (GDB)”.
Note that if you want to use the shortcut button, make sure that the correct project
is selected in the Project Explorer.

When debugging the project, the tool asks you to open the Debug Perspective.
Check the “Remember my decision” box, and click the “Yes” button to proceed.

10
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The Debug Perspective allows you to control the execution of your program by
setting breakpoints, suspending launched programs, stepping through your code, and
examining the contents of variables.

Initially, the program is suspended on the first line of the main function, highlighted
in green, as shown in Figure 9.

B30 Debug - Lab1/src/Labl.c - Xilink SDK ' o | G [
File Edit Source Refactor Navigate Search Project XilinxTools Run Window Help
i gl hecREE ®» DD AT XN B0 U-®® S [FE G e
Quick Access 2] ‘ fE C/C++ (35 Debug
#5 Debug 22 §0|i% ¥ = O ||®- Variab... 32 | @ Break.. | i Regist... | [} XMD ... | @l XSDB ... | B\ Modules| = &
4 &, Labl.elf [Xilinx C/C++ application (GDB)] S0 & lcs et ©
4 XMD Target Debug Agent (2015-06-29 19:22) (Suspended) Name Value
4 o Thread [1] (Suspended: Breakpoint hit.)
= 1 main() Labl.c:10 0x000006ac
p mb-gdb (2015-06-29 19:22)
gl UAdimni\EITO70\NewLabs\EIT070\Lab1\Debug\Labl.elf (2015-06-29 19:22) [Conso
< | m » < »
|4 system.hdf |, system.mss [€ Labl.c &2 | [€] microblaze_interrupt_handler.c = B || g% Outline 2 = 8
i > VY o % Y
® b:char

@ main():int

m

if (b<10){
b--;
} o

£ Target.. 2| = O ||E Con.. 2| Tasks & Ter.. | [20 Prob... @ Exec...| 0 Mem..| = 5 ||[E] sDKLog 52

£ 40 | G BE(EE) =% B~ 8 v || 15 WARN
-4 Local [default] Labl.elf [Xilinx C/C++ application (GDB)] U:\dimni\EIT070\NewLabs\EIT070\Lab1\D¢
(= Auto Discovered Process STDIO not connected to console. - ihs o ository
If you'd like to see UART output in this console, please modi ¢ Project 'MicroBlazePlatform' creatq_
19:21:46 INFO : FPGA configured successfully with |
19:22:31 INFO : Processor reset is completed for m:
Q = > < [0 »
Writable Smart Insert 10:1

Figure 9. Debugging the main program

By adding expressions, you can trace the changes of different expressions, or
variables, as the program is running. To open the expression view, from the Window
menu, select Show View=>Expressions. To add a new expression, click the “Add
new expression” button and type the expression that you would like to evaluate. To
evaluate the current value of a given variable, type the name of the variable. An
example to evaluate the current value of the variable “b” is provided in Figure 10.

11
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B Debug - Labl/src/Labl.c - Xilinx SDK = B R

File Edit Source Refactor Navigate Search Project XilinxTools Run Window Help

£ X I R AR ABER N PO UrE® “ v e |
Quick Access [ D‘ C/C¢+

& |35 Debug 2 i ¥ = B || vari.. |6 Exp... 52 |9 Bre... | 1% Reg...| 3 XM... @l XS.. [BAMo.. | = & | &

£ 4 & Lablelf [Xilinx C/C++ application (GDB)] - L E| 4+ % KR| S T

4 XMD Target Debug Agent (2015-07-01 15:43) (Suspended)

@ '\eeo’ ald
4 o Thread [1] (Suspended: Breakpoint hit.) = w
= 1 main() Labl.c:10 0x000006ac ‘ —
5 mb-gdb (2015-07-01 15:43) L

2 UAdimni\ FITO70\Newl ah<\FITN70\ ah1\Dehia\l ab1.elf (2015-07-01 15:43) ~ -
n » < n % | 4 )

<
4 system.hdf i, system.mss [€ Labl.c 2 | [¢] microblaze_interrupt_handler.c = 0
* Labl.c

* Created on: 29 jun 2015
Author: eit-dni

m

char b;
int main(){
» b=9;
while (1==1){
if (b<1@){
h--:

El Console 22 | v Tasks| & Terminal E.— Problems | (2 Executables| (3 Memory ‘ % B ‘ =B~y = 08
Labl.elf [Xilinx C/C++ application (GDB)] U:\dimni\EITO70\NewLabs\EIT070\Lab1\Debug\Labl.elf (2015-07-01 15:43) [Console not connected to process stdio]

Process STDIO not connected to console.

If you'd like to see UART output in this console, please modify STDIO settings in the Run/Debug configuration.

Figure 10. Evaluating the value of a variable

Observe that you can change the formatting of the value to either see the default,
decimal, hexadecimal, octal or binary representation. To do so, on the Value field, in
the Expression view, click the right mouse button, select Format, and change the
formatting.
At this point, the program is suspended, i.e. it is not running. From this point, you
can either step through the code or you can let the program run. To step through the
code, click the “Step Into” - button. After each step, the program is again
suspended. If you decide to run the program, click the “Resume” ¥ button. If you
want to suspend the program from running, click the “Suspend” " button.
Click the “Resume” U button and let the program run for a while, and then click
the “Suspend” " button.

* What is the value of the variable “b”?

* What is the binary representation of “b”’?

Terminate the program by clicking the “Terminate” ™ button.

In the Debug Perspective, you can also examine/modify the contents of the
memory. To do this, first start debugging the program. Next, in the Debug
Perspective, from the Window menu, select Show View—=>Memoty. In the Memory

12
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view, you can add a monitor, to inspect/modify a given memory location. To add a
monitor, click the “Add Memory Monitor” button. A pop-up box appears as shown
in Figure 11. Type in the address “0x1a80” and click the “OK” button.

r@ Debug - Labl/src/Labl.c - Xilinx SDK o 8] X
File Edit Source Refactor Navigate Search Project XilinxTools Run Window Help

mifhg e EEE o RRIELBPITR N B-OQ-OES S~ ~Hl ooy

Quick Access B ‘ C/C++

& | 5 Debug 2 [i% ¥ = O ||®=Vari.. 6 Exp... 2|9 Bre... | ¥i! Reg...| 3 XM... @l X5.. |BAMo.. | = & | &

44| 4 & Lablelf [Xilinx C/C++ application (GDB)] - < B + % %| s v | g=

4 XMDTargetDebugAgent (2015-07-01 15:43) (Suspended) Name Value 9xag <b> "" e

4 Thread [1] (Suspended: Breakpoint hit.) 3 ; 5’3\/ “&b" 0x00000290

= 1 main() Labl.c:10 0x000006ac 5 Add .
o8 mb-gdb (2015-07-01 15:43) X 200 hew opreson

5 UAdimni\ FITN70\Newl ah<\FITO70\ ah1\Debiin\l ah1.elf (2015-07-01 15:43) 7 e
1m » < 1 b | B4 »

«
|4F system.hdf |, system.mss [€ Labl.c 52 | [ microblaze_interrupt_handler.c = 0

* Labl.c

Created on

Author

m

char b;

int main(){
b=9;
while (1==1){
if (b<10){
< o »
[ Console | ¥ Tasks | & Terminal [;_ Problems | {2 Executables | § Memory 2 ¥ i”“ EH) ‘ v v=2a

Monitors

A Monitor Memory l&]

Enter address or expression to monitor:

0xa80] -

'(?j' [ OK ] [ Cancel

Figure 11. Adding a memory monitor

The memory is byte addressable (8 bits are stored at each memory address). The
memory is displayed as a matrix, where the memory address is obtained by summing
up the row number and the column number.

By default, the memory monitor shows a view where 4 bytes (8 hexadecimal digits)
are combined together, and 4 such entries are displayed per row. However, the
Memory view allows you to change the layout, i.e. how many entries per row, how
many columns to be combined to present an entry. To change the layout, position
the mouse over the memory, click the right mouse button, and select “Format”. In
the pop up window, you can specify the row size, i.e. the number of units (bytes) to
be displayed per row, and you can select how many units (bytes) to be displayed per
column. In Figure 12, we show the settings for a layout where one word (4 bytes) is
displayed per row and each column displays one byte. Click the “Save as Defaults”
button to have this layout as default.

13
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43| 4 £ Labl.eff [Xilinx C/C++ application (GDB)] - B+ % %S <&
4 XMD Target Debug Agent (2015-07-01 15:43) (Suspended) Name Value 0xa%8 <b> " .5
4 P Thread [1] (Suspended: Breakpoint hit.) XaY wgypon B
= 1 main() Labl.c:10 0x000006ac Rai Ai(:; . 00000020 B
5 mb-gdb (2015-07-01 15:43) W Add new expression
A UAdimni\FIT070\Newl ah<\FITO70\ ah1\Debuatl abl.elf (2015-07-01 15:43) ~ -
< m » « 0 o ¢ )
| 4§ system.hdf | M, system.mss [€ Labl.c 2 | [c] microblaze_interrupt_handler.c = 08
* Labl.c
* Created on: 29 jun 2015 ( N
Author: eit-dni B Format... S |
Please specify column and row size.
__ char b; Row Size: unit(s) per row
= int main(){
b b=9; Column Size: unit(s) per column
while (1==1){
if (b<10){ Save as Defaults
h--: . -
Preview: »
& Console | ¥ Tasks | & Terminal | 7.0 Problems | (3 Executables | @ Memory 52 = B8
= = = Address> X X X X -
Monitors L % . 2 n <
4 % %% (0xaB0:0xA80 <Hex> 23 . < New Renderings... <Address> | X 1% |x |x
@ 0xa80 Address @ - 3 4-7 8 -8 C <Address> X X X X N
<Address> X X X X
Default Row Size: 16 unit(s) per row ‘= ‘
G00BOACO 200 " Default Column Size: 4 unit(s) per column
Restore Defaults
@OOBDAER |
=
20 I @ oK Cancel -
1 3

Figure 12. Changing the layout of the memory window

Next, step through the program. Answer the following questions.

Are there any changes in the memory?

Which memory address is affected?

Compare the contents of the variable “b” with the contents of the affected
memory address. What is the conclusion?

What is stored at that memory address?

Modify the contents of the memory address next to the affected memory

address by typing a non-zero value at that address. Does this have any impact
on the variable “b™?

How many bits are required to store a variable of type char?

Run the program.

* Why is the value of the variable “b” larger than 10?

Terminate the program by clicking the “Terminate” ® button.

In the rest of the assighments of this laboratory exercise we shall examine the
different data types in C, and how they are stored in memory. Before you start with a
new assignment, comment the contents of the “main.c” file. A comment starts with
“/*” and ends with “*/”. At the beginning of the comment put a note such that you
know to which assignment the commented code belongs to.

14
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Assignment 1.

The purpose of this assignment is to analyze the “unsigned char” data type.

Open the C/C++ perspective, by clicking the HEC/C+ jcon in the top-right corner.
Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

unsigned char b;
int main(){

b=9;
while (1==1){
if (b<10){
b--;
}
}

Build the project after you have done the changes, and then debug the program. In
the debug perspective, run the program by pressing the “Resume” ¥ button.

* At which memory address is the variable “b” stored?
* What is the value of the variable “b”?

* Why is the value different compared to the previous case?

* How many bits are required to store a variable of type unsigned char?
Terminate the program, and switch to C/C++ perspective.

Assignment 2.

The purpose of this assighment is to analyze the “int” data type.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

int b;
int main(){
b=9;
while (1==1){
if (b<10){
b--;
}
}
}

15
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Build the project after you have done the changes, and then debug the program. In

the debug perspective, step through the program by pressing the “Step Into” -
button.

* At which memory address is the variable “b” stored?

* Modify the contents of the memory address next to the affected memory
address by typing a non-zero value at that address. Does this have any impact
on the variable “b™?

Undo the modifications from the previous step, and keep on stepping through the
program, until the value of “b” has reached the value of zero. Step through again
and make sure that the statement “b--"is executed.

* What happens in the memory?

* How many bytes are needed to store a variable of type int?
Run the program.

* What is the value of the variable “b”’?
* What is the binary representation of “b”’?

* What is the hexadecimal representation of “b”?

* At which address is the most significant byte of the variable “b” stored?
* At which address is the least significant byte of the variable “b” stored?

* Which format is used (big vs. little endian)?
Terminate the program, and switch to C/C++ perspective.

Assignment 3.

The purpose of this assignment is to analyze the “unsigned int” data type.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

unsigned int b;
int main(){

b=9;
while (1==1){
if (b<10){
b--;
}
}

Build the project after you have done the changes, and then debug the program. In

1,

the debug perspective, step through the program by pressing the “Step Into” -
button.
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* At which memory address is the variable “b” stored?

* Modify the contents of the memory address next to the affected memory
address by typing a non-zero value at that address. Does this have any impact
on the variable “b™?

Keep on stepping through the program, until the value of “b” has reached the value
of zero. Step through again and make sure that the statement “b--"" is executed.

* What is the value of the variable “b”’?
* What happens with the memory?

* How many bytes are needed to store a variable of type unsigned int?
Run the program.

* What is the value of the variable “b”’?
* What is the difference when the keyword “unsigned” is used?

Terminate the program, and switch to C/C++ perspective.

Assignment 4.

The purpose of this assignment is to analyze the array data type. In particular, this
assighment focuses on an array of elements where each element is of type char.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

char b[10];
int main(){
int i;
while (1==1){
for (i=0;i<10; i++)
b[i]=1i;

Build the project after you have done the changes, and then debug the program. In

L

the debug perspective, step through the program by pressing the “Step Into” -
button. Open the memory view and observe what happens as you step through the
program.

* What is the value of the variable “b”?

* What does this value represent?

* Where in the memory, are the elements of the array stored?
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* What is the address of the element b[3]?
* What is the size of each element of the array?

Terminate the program, and switch to C/C++ perspective.

Assignment 5.

The purpose of this assignment is to analyze the array data type. In particular, this
assighment focuses on an array of elements where each element is of type int.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

int b[10];
int main(){
int i;
while (1==1){
for (i=0;i<10; i++)
b[i]=1i;

Build the project after you have done the changes, and then debug the program. In

L

the debug perspective, step through the program by pressing the “Step Into” -
button. Open the memory view and observe what happens as you step through the
program.

* What is the value of the variable “b”?

* What does this value represent?

* Where in the memory, are the elements of the array stored?
* What is the address of the element b[3]?
* What is the size of each element of the array?

Terminate the program, and switch to C/C++ perspective.
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Pointers

As shown with the previous examples, variables of different types (int,char) are
stored in memory. A memory address is associated to each variable, and the value of
the variable is stored at that memory address. In C, a special operator “&” (address
of) is used to obtain the memory address at which a variable is stored. For example,
given that a variable “b” is declared, the memory address where this variable is
stored can be obtained by using the expression “&b”. Next, we discuss a new type of
a variable, i.e. a pointer. A pointer is a variable whose value is interpreted as a memory
address. This allows a pointer to read/change the contents of the memory address to
which it points to. Since at a given memory address a specific data type is stored,
when a pointer is declared, it is declared such that it points to a memory address
where a specific data type is stored. In C, a pointer is declared as:

<data_ type> *pointer name;

The previous line declares a pointer (pointer_name) that points to a memory address
where a specific <data_type> resides. By using the declared pointer, we can access
(read or write) the memory address to which it points. The following line shows how
to write to a memory location where the pointer points to:

*pointer name=5;

Next, we show an example on how to use pointers.

Assignment 6.

The purpose of this assighment is to get a better understanding on pointers. In
particular, in this assignment we shall use an example of a pointer that points to
char type.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

char *address;

char b;

int main(){
b=0;
address=8&b;
*address=5;
while (1==1){
}

Build the project after you have done the changes, step through the code, and after
each step answer the following questions.
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* What is the value of the variable “b”’?
* What is the value of the variable “address’?

Check the contents of the memory at the address pointed by the variable “address”.
* What is stored in the memory at that memory address?

* What is the value of the variable “b”?
* What is the memory address of the variable “address’?

Assignment 7.

Comment the contents of the “main.c” file, and add the source code, as shown in
the figure below.

char *address;

int b;

int main(){
b=OXFFFFFFF;
address=(char *)&b+3;
*address+=0xFo;
while (1==1){
}

Build the project after you have done the changes, and then step through the code.

Explain what this code does.

20

Computer Organization, Lab Assignment 1 January, 2017



|/O handling

In many computer systems, the processor (CPU) communicates with other devices.
These devices may be input devices (keyboard, mouse, scanner), in which case the
processor receives data from these devices, or output devices (printer, monitor)
where the processor sends data to these devices. Furthermore, it is possible to have
devices that at different points in time operate as input or output devices. Think of a
printer/scanner device. When used for printing, this device operates as an output
device. However, when used for scanning, the same device operates as an input
device. Such devices are called I/O (input/output) devices. To communicate with
other devices, the processor needs to address the different devices that are
connected to it. This is similar to how the processor addresses different memory
locations in the memory. However, when it comes to peripheral devices, there are
two main methods on how the processor communicates with these devices, i.e.
memory-mapped 1/O and isolated I/O. In the case of memory-mapped 1/O, the
same address space is used to address the memory and the peripheral devices. In
such case, when the CPU accesses an address, it may refer to a portion of physical
RAM, but it can also refer to memory (registers) of an I/O device. Thus, the entire
memory space is shared between memory and peripheral devices. The advantage of
memory-mapped 1/O is that the processor can use the same instructions when
accessing memory or 1/O devices. In case of memory-mapped 1/O the different
registers (control, status and data) of the device are mapped to different memory
addresses. Given that these addresses are known in advance, by using pointers, we
can write software such that we can configure and send/receive data, and check the
status of these devices.

Assignment 8.

In this assighment, we show how we can use the 16 switches and the 16 LEDs on
the Nexys 4 board. Both the switches and the LEDs are interfacing the
microprocessor through memory-mapped 1/O devices. The SWITCHES device is
a configurable I/O device that interfaces the 16 switches on the Nexys 4 board to
the MicroBlaze microprocessor and the device LEDS is a configurable I/O device
that interfaces the 16 LEDs on the Nexys 4 board to the MicroBlaze
microprocessor. Each device has one 32-bit control and one 32-bit data register.
The control register is used to control the data flow direction for each bit of the data
register, i.e. each bit of the data register can be configured either as an input or
output. The SWITCHES device has to be configured as an input device, such that
each bit in the data register of this device is configured as an input, i.e. the state of
each switch on the board is input information that the processor can read. On the
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other hand, the LED.S device has to be configured as an output device, such that
each bit of the data register of this device is configured as output, i.e. the processor
will control the state of the LEDs on the board. The devices are configured by
accessing and writing to their corresponding control registers. Since each of the I/O
devices has a control and a data register that are already mapped to known memory
addresses, for the ease of use, we create a header file where we define labels (macros)
to refer to these particular registers (memory addresses).

To create a new header file, in the Project Explorer locate the “src” folder, right
click, and from the popup menu select “New->Header File”. Use
“address_mapping.h” as a name for the new header file that you are about to create.
In the newly created file “address_mapping.h”, copy and insert the following lines
between the “#define” and “#endif” directives:

#tdefine SWITCHES_DATA (unsigned int *) ©x40020000
#tdefine SWITCHES_CONTROL (unsigned int *) ©x40020004
#tdefine LED_DATA (unsigned int *) ©x40010000
#tdefine LED_CONTROL (unsigned int *) ©x40010004

The header file contains definitions for different pointers. For example, to access the
control register of the LEDS device, we can use the pointer “LED_CONTROL” which
points to a memory address “ex4ee10004” and accesses a 32 bit data (the size of the
control register is 32 bits). Fach of these 32 bits configures the corresponding bit of
the data register of the LED.S device as either input or output. When a particular bit
in the control register is set to “0”, the corresponding bit in the data register is
configured as output, i.e. the data flows from the processor to the device. When a
particular bit in the control register is set to “1”, the corresponding bit in the data
register is configured as input, i.e. the data flows from the device to the processor.
Since the LEDs are used to output information, we need to ensure that the control
register for the LEDS device, i.e. “LED_CONTROL”, is configured such that each of its
bits is set to “@”. Remember that “LED_CONTROL” is a pointer that points to the known
memory address “ex4ee10004”. To write to this register, we need to dereference the
pointer, 1.e. we use “*LED_CONTROL.

The following code shows a simple example on how we can use the definitions from
the header file to enable access to the memory-mapped devices.
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#include "address_mapping.h"

unsigned int state;
unsigned int counter;
int main(){
*SWITCHES_CONTROL=OXFFFF;
*LED_CONTROL=0x0;
counter=10;
while (1==1){
while (counter>=0){
state=*SWITCHES_DATA;
*LED_DATA=counter;
counter--;

Debug the program by stepping through the code. After each step, modify the state
of the switches. Follow the changes for each of the variables, and the memory
mapped registers of the two I/O devices. Answer the following questions:

At which memory address is the variable “counter” stored?
At which memory address is the variable “state” stored?
Does the variable “state”, at every point in time, have the same value as the data
register of the switches? Explain the reasoning behind your answer.

Assignment 9.

Study the code below. Do you expect any difference?

#include "address_mapping.h"

unsigned int state;
int main(){
*SWITCHES_CONTROL=OXFFFF;
*LED_CONTROL=0x0;
*LED_DATA =10;
while (1==1){
while (*LED_DATA>=0){
state=*SWITCHES_DATA;
*LED_DATA=*LED_DATA-1;
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Comment the contents of the “main.c” file, and add the provided source code. Build

the project and debug the program by stepping through the code.

What do you observe on the board?

Open the “Expression” view in the debug environment, and check the contents of
the expression “*LeD_DATA”. How is the expression evaluated?

What happens when the program reads a write-only memory location?

Assignment 10.

Write a sample code that writes to the data register of the SWITCHES device. Check
in the memory window to see the contents of the data register (“*SWITCHES_DATA”).

Do you observe any changes?

What happens when the program writes to a read-only memory location?

Assignment 11.

Write a program that based on the state of the switches, turns on/off the
corresponding LED. For example, if the right-most switch is on, the right-most
LED is turned on.

Assignment 12.

Write a program that based on the state of the switches, will turn on a number of
LEDs that corresponds to the number of switches that are turned on. For example,
if three switches are turned on, then only the rightmost three LEDs should be
turned on. Hint: the decimal number 2"-1 has a binary representation that contains
n ‘1’s. Note that you are not allowed to use C library functions to implement the
function that computes power of a number.
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